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  INTRODUCTION AND DIRECTIONS FOR USE 

Thank you for purchasing the Safescan TA-software. Combined with the TA-8000 series Time Attendance terminal it provides a complete 
solution for efficient time registration. Before starting to install and use the software, we recommend that you carefully read this user 
manual and keep it at hand for future reference. The user manual describes the basic set-up of the software, the advanced settings and 
usage scenarios as well as details of each menu item of the device. 

  1. THE BASICS

1.1 MINIMUM SYSTEM REQUIREMENTS 
In order to use the TA software, your computer needs to meet the following minimum requirements:
• Free hard drive space: 100 MB •   Display resolution 1024 x 768
• Memory: 1GB    •   WiFi or Ethernet (LAN) connection for real-time features.
• Operating System: Windows 7 •   USB port

1.2 INSTALLING THE SOFTWARE
Download the software from the provided link, extract the .zip file and double click on taSetup.exe to run the installer. Follow the instructions displayed on 
the screen, select the software language and the destination folder where you want to install the software.

1.3 ACTIVATING THE SOFTWARE

 Differences between TA and TA+ software: “TA” is the regular time and 
 attendance software from Safescan, providing you with all you need for
 basic time registration and reporting. “TA+” offers additional functionality
 for more advanced needs, for example a graphical planning management 
 tool and advanced work code functionality. 

After installing, the software will run as TA+ version for 30 days. You can enter 
your license key at any time. While in trial mode, the software will show the
license management screen upon start-up. If you have not entered a license key 
after 30 days, the software will prompt you to do so in order to continue
using it. If you enter a TA license key, you will still be able to run the 30 day 
trial of the TA+, and see for yourself if it is worth upgrading.

1.4 SCREEN LAYOUT MENU BAR
The menu bar at the top of the window gives 
you access to all the screens of the software. 
As with any standard Windows top bar menu, 
you can either make selections with mouse clicks 
or by using the Shortcuts bar (also available 
through a combination of the ALT and another key). 
This bar gives you access to the mostly used 
functions of the software such as the reports, or the 
management screens.

Menu Bar

Shortcut Bar

Table
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1.4.1 TABLES
Tables. Many screens of the software display data in tables. These tables share common features.

Sort data

You can sort the data in the tables by clicking on the header of the column you want to sort. Another click will reverse the sorting order.

Rearrange column order
You can rearrange the column order in the tables by dragging any header to the desired location.

Toggle columns visibility
A right-click on any column will display a list of all columns available to display. Click on the column names you want to show/hide.

1.4.2 FILTERS
You will find filters on most screens of the software. These filters will help you get relevant data in a quicker and more efficient manner. User text filter: 
Enter the first letters of the name of the user you are looking for. Department filter: Gives you all data related to one chosen department. User filter: 
Gives you all data related to one specific user. Report range filter: Select one pre-defined range, or click on “Select…” at the bottom of the list to 
choose specific dates in the “Report from” and “Report to” filters. Report from filter: Select the start date of your report range (this filter is only enabled 
if you have chosen Select…”in the “Report range” filter. Report to filter: Select the end date of your report range (this filter is only enabled if you have 
chosen ” Select…”in the “Report range” filter. Type filter: Present in the graphical screens (in Clock Grid as Report type, and in Planning as Planning 
type). You can change the way graphical data is displayed on your screen. Day: Displays all days of the selected period on one line. Week: Displays the 
days of the selected period one week per line, with Monday being the first column. Month: Displays the days of the selected period one month per line. 
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Month - Weeks: Displays the days of the selected period one month per line, also adds the day names. End of day filter: In the various report screens 
of the software, you will find an “End of day” filter. It allows shifting of the end of the working day to a given time, providing easier reading of shifts going 
from one day to another. For example: If the user finishes his shifts around 3 in the morning, set the “End of day” filter 04:00. If your users do not work 
after midnight, leave the filter to 00:00. 

1.4.3 MOST COMMON ICONS
You will find the following icons on several screens of the software: 

 

1.5 LANGUAGE SELECTION
During the installation you were prompted to select the desired language. If the selection was correct, you can proceed directly to the next point. If you 
wish to change your language, select File -> Preferences from the top menu (Keyboard shortcut: ALT + F + P). Select the desired language in the 
language drop-down list.

1.6 CONNECTING THE SOFTWARE AND THE TERMINAL(S)
The connection to your Time Attendance terminal can be set up from the ‘Device’ page in the software.

  

Generates a .CSV file with the data of the current table. After clicking Export, a dialog box will pop-up prompting you to   
give a name and a location for the .CSV file.
Note: there is one exception: clicking on Export from the Report screen will generate a .PDF file.

Generates a .PDF file of the current table and attaches it to an email message. For this function to work, you need to have a mail client 
software, such as Outlook installed on your PC.

Sends the data of the table to your printer.

Gets the latest data from the terminal and the database.

Click on the Save icon on the left of the screen. A pop-up window will appear, inorming you that the software must be restarted. 
Next time you start the software, it will be displayed in the selected language.

In the top menu, select Edit -> Device, or click on the “Device” icon in the shortcut menu bar (keyboard shortcut: ALT + E + E).
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The TA software can communicate with your time attendance terminal by using a USB stick or by connecting your terminal to your network. When 
connected to the network the user clocking data will automatically be transferred to the software. For data collection and user synchronisation via USB 
please refer to the user manual of your TA terminal.

1.6.1 USB STICK
 

Please specify a name for your device, then click on the ‘this computer’ button and select your language, if applicable*, in the ‘Device Language’ drop-
down list. The software is now ready to receive data from a USB pen drive. *If your required language is not present in this list then select ‘Other’.

1.6.2 NETWORK
To set the IP address on your Time Attendance terminal please refer to the user manual of your TA-terminal. Setting up a connection to a network- 
connected Time Attendance terminal is an automated process. 

  

To set up the USB Stick please click on the “Add” button located on the top right of the page. This will open the following pop-up:

Simply click on the “Scan” button  on the top right of the page and a pop-up displaying the IP address of your terminal will appear on 
the screen.
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Click ‘Yes’ to establish connection between the device and the software.

The device will appear as connected on the page. To edit the terminal information (e.g the name), simply double click on the connected device and you will 
be able to edit any of the given fields.Your terminal is now connected to the software.

1.7 CREATING DEPARTMENTS
Creating departments will, especially when managing a large amount of users, help you manage them and their clocking data more effectively. It will also 
allow you to generate reports on specific groups of users or departments. 

On the ‘Department’ page in the software you will find one default department. Both the name and description are defined by a question mark. You can 
edit this by double clicking the line or by following the steps below.

      

In the top menu, select Edit -> Department, or click on the “Department” icon in the shortcut menu bar (keyboard shortcut: ALT + E + 
D).

Click on the department line, the background changes to blue, then click on the edit  button and a new window will pop-up.
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Change the name and the description, and click on ‘OK’.

      

1.8 CREATING USERS
There are two ways of creating a new user. You can either start from the software or from your Time Attendance terminal. Even though you can use both 
ways, we would recommend you start from the TA device, since it minimises the chance of mistakes and prevents the mix-up of user data. 
Please note: After every change you have made to the users, you will need to synchronise the software with the device.

1.8.1 STARTING FROM THE TERMINAL
Register the user on the device (as explained in your device manual) and make sure that communication is established between the software and the device.

  

The software will now check again for differences. If no difference is found, it will display the message ‘No changes found’. Your user(s) is now 
synchronised with the software and the device.

To add more departments, click on the “add” button located at the top right of the page and fill-in the details in the pop-up  window, 
saving each time by clicking ‘Ok’.

Go to the ‘Device’ page (ALT + E + E) and select your device.

Click on the ‘Synchronize ’button  at the bottom left of the page and a new window will pop-up displaying the differences between the  
data in the software and on the device.

Send the data from the terminal to the software by clicking on the ‘TA > PC’ button.

Validate your choice by clicking on the “Commit” button.
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The ‘System Data’ tab shows the minimal amount of data you need to set in order to have your user recognised correctly by the TA terminal.

1.  User name: this is the name that will also be displayed by the TA terminal; it can be a maximum of 8 characters long.
2.  Privilege: the default value is ‘user’, you can change it if you want to grant more rights to the user.
3.  Status: make sure it is set to ‘active’.
4.  RFID Number: When applicable, fill-in the number written on the RFID card (when printed) that you want to link to the user.
5.  Password: You can set a password for the user. This will allow him/her to login in the software or to clock on the TA terminal. When creating a user 
  in the software, the value of the password is the same as the given user ID. If you also want to use the password on the TA device it must be numerical 
  only and no longer than 5 digits.
6.  Work schedule: You can link the employee to a work schedule (see section 4 of this manual).

Go to the User page (ALT +E+U) to edit the user data.

Select the user you want to edit and click on the ‘Edit  button.

When finished, click on the “Save” button.
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1.8.2 STARTING FROM THE SOFTWARE

The following pop-up will appear:

The software automatically selects the next free user ID. It is possible to change the user ID, however due to the way the software and the clock 
communicate we strongly recommend you to keep the designated User ID. Select a department for your user from the drop-down list, and click on OK. 
You can now enter the user data.

 About User ID’s: The terminal and the software make use of user ID’s to retrieve user information. We recommend that you do not change the
  automatically allocated ID’s. If you want re-use some company specific ID’s, please use the “Personnel No” field in the software.

Your user is now synchronised from the software to the terminal. When applicable, if you want to register fingerprints for your users, please refer to the 
user manual of your TA terminal.

Go to the ‘User’ page (ALT + E + U), and click on the “Add” button located at the top right of the page.

When finished, click on the “Save” button.

You now need to send the user data to the Time Attendance terminal. Go to the device page (ALT + E + D), and select your device.

Click on the “Synchronize” button at the bottom left of the page and a new window will pop-up displaying the differences between the  
data on software and the device.

Validate your choice by clicking on the “Commit” button.

Send the data to the terminal by clicking on the “PC > TA” icon.
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 Please note: If have created a user with more privileges than normal user privileges - either in the software, or synchronised from the device -, the   
 software will prompt you for a username and password at startup.

1.9 WORK SCHEDULES
Depending on the use of fixed or variable work schedules with your company the TA software provides you with two ways of applying schedules to

your members of staff. If your employees work with regular work schedules that do not vary from week to week, follow the instructions below. If you 
require more flexibility or variation in the work schedules due to changeable work patterns and/or day- and nightshifts: this will be covered in the chapter 
“planning”. It is still advisable to follow the instructions below as the regular work schedules share many similarities with the variable schedules.

 

Fill-in the name and the description for your work schedule in the pop-up and click OK. At the bottom of the page the following field will become visible.

As an example we will use the following schedule. The employees work Monday to Thursday from 9:00 to 17:00 and from 09:00 to 15:00 on Friday’s. 
Every day they clock for their lunch break from 12:00 till 13:00.

In the top menu, select Edit -> Work Schedule, or click on the “Work Schedule” icon in the shortcut menu bar (keyboard shortcut:
ALT + E + O).

Click on the “Add” button located on the right at the top of the page.
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By clicking in the ‘Day of week’ cell a day selection drop down becomes available to select the required days.

The start type automatically defaults to ‘In’. For our example the start time is 09:00 and the end time is 17:00.

As the working hours for Friday differ from the rest of the week we need to create a second line with hours from 09:00 to 15:00.

To set up the ‘clocked’ lunch break we will set up a third line. As the employee(s) go to lunch at the same time every day we can use one line even though 
the start and end times of the day vary. We will indicate that employees have a clocked break between 12:00 and 13:00. First we select the days from 
Monday to Friday, then we will change the start type* to ‘Excl break’ and fill-in the start time and the end time.

   * Regarding the start types: There are four different start types: In: used to notify the start of the working day. Break Incl: Is used if the breaks are part 
 of the working day. This is for information purposes only and has no impact on the total worked hours. Excl break: Use Excl break when employees 
 clock in and out for their break.  Break impl: Is used if you want break(s) to be deducted automatically from the total worked hours without the 
 employees clocking for it.

Our work schedule is now completed; we can save it by clicking on the “Save” icon  at top of the schedule. If the icon stays inactive, it  
means that there is a conflict in the schedule that will need solving.
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1.10 WORK CODES
Work Codes are a key element of the TA+ software, and they can be used for several different purposes. They can be used to specify time spent on 
specific projects but are also used in absence registration.

      

The software has some pre-defined standard work codes. These can be edited and customised to suit your own needs when required.

Explanation:
Work code: This is the work code ID, it is not necessary to change it but it is possible to change it (e.g to reflect an account or job number). 
Name: The name of the work code (this field is mandatory). 
Description: The description of the work code (this field is mandatory). 
Work code type: There are several different work code types. The impact they have on the counting of hours varies from type to type. This will be 
explained in detail in the “planning options” section. When creating regular work codes, use ‘Scheduled time’. 
Regular out: Allows the software to understand the work code has been used to indicate the end of the day. 
Colour: Change the colour of the work code in the planning and the Clock grid.

To sum up: when creating a regular work code: fill-in the name, the description and choose a colour.

In the top menu, select Edit -> Work Code, or click on the “Work Code” icon in the shortcut menu bar (keyboard shortcut: ALT + E + 
W).

To add another work code, click on the “add”  button located on the top right of the page and a window will pop-up.
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1.10.1 REGULAR OUT 

  

When a user clocks out using a work code, the software considers that the user is still working. Using a work code with “Regular out” checked allows to 
signify that the user is not working anymore. This option can be used for leaving early during work time. Example: We will use two work codes to illustrate 
this functionality: The first work code is used for work done outside of the office. The second one is used for leaving early, “Regular out” is checked:

Let’s review the following actions for a user with a work schedule running from 9 to 17:30 with an Implemented Break between 12 and 12:30:

On the first day(13/08), the user has clocked out at 15:00 with the “work outside office” work code ( “Regular Out” not checked), the day is automatically 
closed at 17:30 (time of the work schedule) and 2:30 hours are counted as work outside of the office in the work code report.

On the second day(14/08), the user has clocked out at 15:00 with the early leave work code (“Regular Out” checked), we can see on the report that this 
results in a negative balance of 2:30 hours.
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   2. ADVANCED USAGE SCENARIOS (TA+ SOFTWARE VERSION ONLY)

2.1 PLANNING (TA+ SOFTWARE VERSION ONLY)
Chapter 1.9 covered the creation of a work schedule for employees with regular work schedules. We are now going to create a planning with flexible 
schedules for our employees. You can create a planning by assembling various templates. These templates are created by the association of a time plan 
and a work code. We will take the example of a company where employees can work 3 different shifts. One shift runs from 8:00 to 17:00 with a clocked 
break from 12:00 to 13:00. The second shift runs from 17:00 to 01:00 with a break from 21:00 to 22:00, and the third shift runs from 01:00 to 08:00 
without break. Firstly, we will create three different work codes, one for each shift.

Let’s create templates for these shifts. Go to the ‘Planning’ page (ALT + E + P).

On the right side of the screen, you will see an empty table, click on the “Add” icon to create a new schedule template.

Enter a name for the template (in this case Day), then click on the “Edit” button. A new window will pop-up.
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You can fill-in this window in the same way you filled-in the work schedule which was covered in Chapter 1.9.

 

Click on ‘OK’ to save. Select the ‘Day’ work code you have created previously in the work code drop-down list.

We can proceed the same way for the two remaining shifts (Evening and Night).

Save your template by clicking on the “Save plan”icon.
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Select days on the planning at the left side of the screen, and simply drag and drop the desired template. A window will pop-up giving you the option of 
leaving feedback on your operation, you can still change the associated work code or cancel the operation. Click ‘OK’ to save.

Repeat the procedure until you are done with the planning.

   Work code types (TA+ software only): There are 7 different types of work codes, which all have a different impact on the calculations in the software.
 Scheduled time: Regular working hours. Assignment time: Can be used for assignment to projects. Calculated as normal hours. Can be filtered in 
 the planning screen. Vacation time: The hours of the existing work schedule of the user are converted into vacation hours, they are deducted from 
 the vacation hours total. Planned vacation time: To be used to enter vacations for users without regular work schedules. Holiday time: National
 holidays, reported as paid days. Unplanned time: Cancel an existing work schedule. It is possible to add Scheduled time or Assignment time over
 Unplanned time. Sick: Work code type for sick leave, reported as paid time.

2.2 NATIONAL HOLIDAYS AND VACATIONS (TA+ SOFTWARE VERSION ONLY)

2.2.1 NATIONAL HOLIDAYS

The planning of national holidays is a straightforward process. Go to the ‘Planning’ page (ALT + E + P) and click on the ‘import holidays’  
button located on the top right hand side of the page.
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Select your country in the drop-down list of the window that just popped-up. Leave the default selected work code. Validate your choice by clicking ‘OK’.

 Please note: If you have deleted the “Holiday” work code from your work codes list, please create a new work code with “Holiday time” as work code  
 type before importing the national holidays.

2.2.2 VACATIONS
Planning vacations will differ depending on your employees working with a regular working or planning schedule. Employees with regular work schedule:

Let’s create a template to apply on the planning. We will name it as seen previously, but instead of creating a planning for the template, we will specify a 
time range in the ‘Time plan’ cell.

This range has to cover the work schedule linked to the employee. In our work schedule example the employee’s work schedule runs from 9:00 to 17:00. 
We can fill-in 9:00-17:30 in the time plan cell. If you want to cover all types of work schedule, you can fill-in ’00:00-23:59’ in the ‘time plan’ cell.

We do not need to create a new work code for this template, we only need to select standard ‘Vacation’ work code. Save your template by clicking on the 
“Save plan” icon on the right side of the screen
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After that, we only need to select the vacation days on the planning, and drag and drop our vacation template.

Employees with planning:

To plan vacation for an employee working with a planning, drag a template that you already use for this employee over the days you want to set as vacation 
days. When the pop-up window appears change the work code to ‘Vac.P’.

Alternatively, you can also create a template with the correct number of hours linked to the ‘Vac. P’ work code.

2.3 SICK LEAVE (TA+ SOFTWARE VERSION ONLY)
Keeping trace of sick leave:  there are 2 possible scenarios: the employee already has a work schedule or planning, or you have to make your planning 
knowing that an employee is on sick leave. Manage sick leave on the clock grid:

      

Select the day(s) when the person is sick and right-click.

Select ‘Copy schedule to attendant records’, a new window will pop-up. In the work code drop-down list, select the pre-defined ‘Sick’ work code, and click 
on OK.

Your employee is now registered as sick for the selected day (s).

Go to the ‘Clock grid’ page, and select the absent employee.
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2.3.1 MANAGING SICK LEAVE IN THE PLANNING

Proceed as if you were going to plan regular working hours. When the confirmation window pops-up, change the work code to the standard ‘Sick’ work 
code.

Your employee’s sick leave is now managed.

2.4 AMENDING OVERTIME (TA+ SOFTWARE VERSION ONLY)

Over the year, your employees may accumulate overtime hours. The “Amend overtime” function of the software will help you manage these overtime-hours.
Go to the User page (ALT + E + U), and select the user for whom you want to amend the hours. Click on the “Amend” icon, a new window will pop-up.

Click on the “Amend” icon in the top bar of the user information tab

A new window will pop-up. you can choose when to amend the overtime balance.

Go to the User page (ALT + E + U), and select the user for whom you want to amend the hours.
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You can select a type of amendment: Paid hours: the hours are deduced from the overtime balance, they are shown as “paid hours” on the report.
Vacation hours: the hours are deduced from the overtime balance and added to the vacation balance. Other hours: the hours are deducted from the 
overtime balance. You can enter a remark to give more details on the report. Click on OK when finished.
NB: if you want to add hours instead of deducting, place a minus (-) sign before the amount of hours.

A window will pop-up, prompting you to confirm your choice.

You will see list of all amendments made in the report page.

2.5 PAY CLASSES (TA+ SOFTWARE VERSION ONLY)
Pay classes allow you to define a basic pay rate per user, or group of users, and apply rules that modify this basic rate. You will be able to generate a 
report, and display the number of hours linked to each pay rate.
The Pay Class module has been designed to be as flexible as possible, and still remain simple to use.
Each Pay Class has a name and description, and is linked to a basic pay rate. For every Pay Classes you will define a set of rules that will modify the pay-
rate according to the worked hours. Each rule of the Pay Class will be triggered when one or more conditions are met.
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2.5.1 PAY CLASS SCREEN

The bottom part of the screen displays the details of the selected pay class.
On the left side of the bottom screen (1), you can see and edit the basic information of the pay class. In the middle (2) is displayed the list of all rules 
applied to this pay class. Finally, on the right (3) are displayed the details of any selected rule. Rule details (3):

For each rule, you will be able to see/edit the rule name, the multiplying factor, any eventual remark, and a list of conditions.

There are 9 different types of conditions:

• After X hours per day: the rule will be triggered after a certain number of worked hours per day.
• After X hours per week: the rule will be triggered after a certain number of worked hours per week.
• After X hours per month: the rule will be triggered after a certain number of worked hours per month.
• After X consecutive days: the rule will be triggered after a certain number of consecutive worked days.
• After a specific time: the rule will be triggered after a given hour.
• Before a specific time: the rule is triggered when someone works before a given hour.
• During bank holidays: the rule is triggered when a day has been marked as bank holiday (see work codes and planning).
• On specific day(s): the rule is triggered on one or more specific week day(s).
• When using work code: the rule is triggered when an employee uses a given work code.

When using more than one condition for one rule, all conditions have to be matched for the rule to be triggered. If the conditions to trigger more than one 
rule are met, the rule with the highest factor will prevail.

The screen is divided into two sections. On the top you will see the list of existing pay classes as well as their base rate and possible description.
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2.5.2 PAY CLASS REPORT SCREEN

This screen displays the pay class report as a PDF. The report is divided into two sections: on top (1) is displayed the information per day, at the bottom 
(2)is displayed the totals per rules
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2.5.3 USING PAY CLASSES
Creating a new pay class:

Go to the Pay Class management screen (Edit > PayClass)

Click on the ‘Add’ icon located on the top right side of the screen.
A new window will pop up.

Fill in the basic information (name and Pay rate), and press OK.

Add a new rule:

Click on the ‘Add’ icon located on the left in the bottom part of the screen.

Fill in the name and factor (the factor is the multiplier applied to the basic pay rate when the conditions of this rule are fulfilled).
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Add conditions

Select a condition in the drop down list. Depending 
on the type of condition selected you will have to 
fill different information (number of hours, number 
of days, specific day or work code…). If you need 
to add more than one condition, click on the [Add] 
button located under the last condition.

When finished, click on the save icon located on the left of 
the bottom part of the screen. It is possible to link this newly 
created pay class with a department or with a single user.

Linking the Pay Class with a department

Go to the department management screen.

Select a department and click on the edit button.

Choose the pay class in the Pay class drop-down 
list. Save.

Linking the Pay Class with a user

Go to the User page, select a user and click on the “Edit” icon

Select the Work Time tab Select the pay class you want to use in the Pay Class drop down list.

Cick Save to save the changes
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Changing the base rate for one user:

You can change the basic pay rate for each user.

In the Work Time tab, enter the desired value in the Base rate field. This will override the basic pay rate of the pay class.

2.5.4 PAY CLASSES IN PRACTICE
Double salary on Sundays:

Create one rule for the pay class, name it and give a factor of 2. Add a “On a specific day” condition and check the box for Sunday. Save.

Double salary on Sundays and Bank Holidays:

Here we have two different rules. We just created the rule applying on Sundays, we now need to add a rule for the bank holidays. Add a new rule, name it, 
and give a factor of 2. Add a “During bank holidays” condition. Save.

Salary *1.5 (150%) after 8 hours per day

Add a new rule, name it, and give a factor of 1.5. Add a “After X hours” condition, set the number of hours to 8. Save.
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Salary * 1.5 (150%) after 8 hours and *2 (200%) after 10 hours per day

Here we have two different rules. We just created the rule applying on more than 8 hours worked, we now need to add a rule for the more than 10 hours. 
Add a new rule, name it, and give a factor of 2. Add a “After X hours” condition, set the number of hours to 10. Save..

Overtime on a Sunday:

This case is managed with one rule with two conditions: the first condition is an “after X hours” condition, here the value is 8. The second condition is “On 
specific days”, with Sunday checked. Save.

1 2

 3. SCREENS OVERVIEW

3.1 PREFERENCES
The Preferences screen can be accessed through the menu bar by clicking on File and Preferences (keyboard shortcut: ALT + F + P).
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3.1.1 SETTINGS

Action: Close year (TA+ only) The Close Year action allows the transfer of all overtime and vacation hours from the previous year to the current year. After 
clicking on the “Close year…”  button the software will generate a report of the modifications. NB: this action cannot be undone. Please make sure that 
the data from the previous year is correct.

3.1.2 IN/OUT TRANSLATION
The In/Out translation table allows the software to deal with the actions performed with the customisable function keys of the Safescan TA-900 and TA-
8000 series terminals. For information regarding the setup of the customisable function keys of the terminal, please refer to your terminal’s manual.

Click on Undo to reverse your changes, or on Save to save them. Those 
two buttons apply to Region, Database, and Back up. 

Database The database connection string determines the path to the 
database of the software. The default value is: .\TADATA.FDB
For more information regarding the database system used by the software, 
please refer to the Firebird database section in the Appendix of the 
present document.

Back up It is possible to create a backup-file of your data. This backup 
can be done manually or automatically.

Add a new item in the In/Out translation table: Click on the Add icon 
located on top of the table, a new line will appear.

In the function column, give a name to the item (you may want to use the 
same name as the one you entered in the terminal).

In the state column, report the state you entered in the terminal.

Region: Select the language for your software.
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3.2 LOG
The Log screen can be accessed through the menu bar by clicking on File and Log (keyboard shortcut: ALT + F + L). The log screen displays the actions 
that have been performed on the device. This can be used by Safescan’s technical support for troubleshooting.

3.3 CLOCK
The Clock screen can be accessed through the menu bar by clicking on Edit and Clock (keyboard shortcut: ALT + E + C). The clock screen displays all 
clocking data as a list. From here you can check, edit, and add clocking data. Anytime an error is detected by the software, the In/Out state of the line with 
a suspected error will be highlighted in Red. It is important to realise that the software can only provide valid calculation results if it is fed with coherent 
data. The following sequences are considered as “valid” by the software: 

 • In - Out
 • In - Break - Return - Out
 • In with work code - In with work code
 • In - In is also considered as valid, even though red highlights will be displayed. All odd Ins are considered as “In”, all even Ins are considered as “Out”.

 Please note: In order to protect the employer and the employee, it is not possible to delete clocking data from the database of the software. 
 A clocking item can be set as ignored so that it is not taken into account for the hours calculation.

Edit Clock time. There are several ways to edit a clock time: 

In the In/Out drop-down list select the desired value.

Click on the Save icon located on top of the table.

Click on the Save icon located on top of the table.

a) Double click on the line you want to edit;  b) Select the line to edit and 
click on the Edit Icon located on the top right side of the screen;

or c) Select the line to edit, right click and click on “Edit clock time”.

Choose the work code you want to associate to the clocking action.

Edit an existing item in the In/Out translation table: Double-click on the 
data you want to edit, enter the new data.
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3.3.1 ADDING A CLOCK TIME
There are two ways to add a clock time:

3.4 CLOCK GRID (TA+ SOFTWARE VERSION ONLY)
The Clock Grid screen can be accessed through the menu bar by clicking on Edit and Clock Grid (keyboard shortcut: ALT + E + L).

You can either click on the “Add” icon located on the top right side of the 
screen,

Both operations will open a new pop-up window.

or right-click directly in the list.

Enter all data and press OK to insert the clock time.  Note: The OK button 
will only become active when all data has been entered.

1

2 3
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The Clock Grid screen displays all clocking data, as well as work schedule hours and planned hours. It gives a simple and straightforward view over the 

“ins” and “outs” of your employees. The screen is divided into three different sections:
1 The filters: for more information regarding the filters of the software, please refer to chapter 1.4 of this manual.
2 The main part of the screen: displaying the clocking data as well as the planning and work schedules.
A red exclamation mark is displayed anytime the software detects errors in the clocking sequence.
3 The work code legend: Shows the colours and the names of the different work codes.

      

3.5 DEPARTMENT
The Department screen can be accessed through the menu bar by clicking on Edit and Department (keyboard shortcut: ALT + E + D). You can find more 
information regarding the creation of departments in chapter 1.7 of this manual.

3.6 USER
The User screen can be accessed through the menu bar by clicking on Edit and User (keyboard shortcut: ALT + E + U). You can find more information 
regarding user creation and management in Chapter 1.8. On top of your users’ “Ins” and “Outs” management the TA and TA+ software offers some 
useful user management features. User information is displayed on four tabs: System data tab: You will find on this tab all information necessary for the 
communication with your 

TA terminal - please refer to Chapter 1.8.1 for the description of all common information between the software and the device.
Personal data tab: This tab displays contact information for the selected user. You can also fill-in the users’ birthday, and the “Joined company” and “Left 
company” dates. 

 
 About the “Joined Company”date: The “Joined company” date has an impact on the calculation of the overtime (TA+ only). When a user starts in the  
 middle of the year, it is necessary to fill the start date, so the software can start all calculations with this date instead of the beginning of the year.

You can choose to display this section, or not, by clicking on the “Workcode”icon located on the top-right side of the filter section.
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Work Time tab (TA+ only):

This tab displays information regarding the hours performed. The tab is divided into two sections: “Annual working hours”, and “Work time previous month”. 
In the “Annual working hours” section, you can set the number of hours an employee is supposed to work during a year. The “Work time previous month” 
section displays the work time performed, the work time scheduled, the overtime, the hours taken and the ovetrtime history.

Vacation tab (TA+ only): It is possible to manage your employees’ vacations from this tab. Please note: Vacation data must be entered as hours: minutes. 
From last year: You can fill-in the remaining vacation hours from the previous year. Correction: If you want to amend the vacation balance from the 
previous year, you can do it in this field. To add hours, simply enter the numbers of hours you want to add (HH:MM). If you need to deduct hours, first enter 
“-” (minus sign) before the number of hours you need to deduce (HH:MM). The total of the two previous fields will be displayed in the “Remaining vacation 
in hours” field. Vacation in hours per year: Fill-in the number of vacation hours available for your employee for the year. Special leave: In those two 
fields, you can add special vacation hours. The sum of the “Vacation in hours per year” and the “Special leave” fields will be displayed in the “Total hours of 
vacation for the current year”field. The total amount of vacation for the year is displayed in the “Total this and last Year”. Hours taken: Displays the number 
of vacation hours already taken. Hours planned: Displays the number of vacation hours planned but not taken yet. Hours remaining: Displays the number 
of vacation still available.

3.7 WORK CODE
The Work Code screen can be accessed through the menu bar by clicking on “Edit” and “Work Code” (keyboard shortcut: ALT + E + W). You can find 
more information regarding the creation of work codes in chapter 1.10 of this manual.

3.8 WORK SCHEDULE
The Work Schedule screen can be accessed through the menu bar by clicking on “Edit” and “Work Schedule” (keyboard shortcut: ALT + E + O). You can 
find more information regarding the creation of work schedules in chapter 1.9 of this manual.

3.9 PLANNING (TA+ SOFTWARE VERSION ONLY)
The Planning screen can be accessed through the menu bar by clicking on “Edit” and “Planning” (keyboard shortcut: ALT + E + P). You can find more 
information regarding planning, creation and management on chapters 2.1 and 2.2 of this manual.
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3.10 DEVICE
The Device screen can be accessed through the menu bar by clicking on “Edit” and “Device” (keyboard shortcut: ALT + E + E). Adding a new device on 
the network or using a USB stick is explained in chapter 1.6 of this manual.

1-Action bar: Depending on your device, and depending on how your device communicates with the software, some icons will be active or inactive.
Synchronise TA-655 logs: Allows to retrieve the logs from a Safescan TA-655 terminal. When the operation is done, you will be asked if you want to 
delete the logs from the device. With the memory of this machine being limited, it is recommended to delete logs every time they have been transferred 
into the software. Set Time: If you are using LAN or WiFi to establish communication between your Computer and your TA device, pressing this button 
will set the time of your computer on your device. Synchronise: Synchronise user data between the software and the terminal(s). For more information 
regarding the synchronisation of users, please refer to chapter 1.8 of this manual. Synchronise Work Codes: TA 900 series and 8000 series only. Send 
all the work codes from your computer to the device. Get logs from USB drive: If you are using a USB stick to establish communication between your 
computer and your TA terminal, pressing this button will trigger the reading of the attendance log file present on the USB stick. Device details: Provides 
information over a specific device. Name: this is the display name of the device. IP address: the IP address of the terminal, leave this field empty when 
using a USB stick. Fetching computer name: the name of the computer handling the communication between the device and the database. In most 
case the fetcher should be the computer running the TA software. Communication key: it is possible to enter a numeric key to secure the connection 
between the device and the software. Device language: this option allows the terminal to adapt to some languages specifications. This computer 
button: sets the current computer as the fetching computer.

3.11 PRESENCE
The Presence report screen can be accessed through the menu bar by clicking on “Report” and “Presence” (keyboard shortcut: ALT + R + P). If your 
device is connected to the network, the Presence screen allows you to see in real time the presence of your employees.

1

2
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 Please note : An employee will be shown as “Out” automatically after a safety period of 96 hours without clocking data.

3.12 DAY

The day screen report displays information one day per line. By default, the screen displays the first In and the last Out in the In and Out columns. All other 
In/Out data is located in the Break In/Break Out columns. It is also possible to display the work schedule and the balance between the work schedule and 
the clocked hours. The first line of the table gives different information: in the “In” column you will get the average In time, in the “Out” column the average 
Out time. In the “Duration” column is displayed the total of all durations in the table. The “Days” column displays the number of worked days. 

 Please note: If something seems incorrect in the report, there is a strong chance that something is wrong with the clocking data. You can look for any  
 errors on the Clock screen, and correct them. 

3.13 PERIOD
The Period report screen can be accessed through the menu bar by clicking on “Report” and “Period” (keyboard shortcut: ALT + R + E). The Period report 
screen displays information for a given period , one line per user.

 Please note: If something seems incorrect in the report, there is a strong chance that something is wrong with the clocking data. You can look for any  
 error on the Clock screen, and correct them.



35www.safescan.com

3.14 REPORT
The Report screen can be accessed through the menu bar by clicking on “Report” and “Report” (keyboard shortcut: ALT + R + R).

The Report screen allows you to generate reports for any given period in an easy to read layout. You will see the Ins and Outs, the daily, weekly, and 
monthly hours and balance (if the user is linked to a work schedule), and any remarks you have filled in”, or left by the system. If you are using the TA+ 
software, you will also have the possibility to display the vacation and overtime hours and amendments, as well as the late arrival and early leave times.

Corrected by the system:
If you see “Corrected by the system” in the “Remarks” column of the report, it means that some clocking information is missing for this specific day, and 
that the software took the information of the work schedule to make the calculations.

 Please note: If something seems incorrect in the report, there is a strong chance that something is wrong with the clocking data. You can look for any  
 errors on the Clock screen, and correct them. Please note: Clicking on the “Export” icon from this page will not generate a .CSV file, but a .PDF file.

3.15 WORK CODE REPORT
The Work Code Report screen can be accessed through the menu bar by clicking on “Report” and “Work Code” Report (keyboard shortcut: ALT + R + 
W). The Work Code Report screen allows you to see the amount of time spent on specific tasks or projects. The results can be grouped by day, person or 
work code.

3.16 ABOUT
The About screen can be accessed through the menu bar by clicking on “Help” and “About” (keyboard shortcut: ALT + H + A). The About screen displays 
information the version of your software, and provide several links to Safecan’s website (Online help, Manual, Support, and Updates).
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 APPENDIX

SUPPORT
If you experience issues/problems with the software, and need help from Safescan’s technical support, click on Help and select Support (keyboard 

shortcut: ALT + H + S), this will launch the Safescan remote support software (TeamViewerQS). Call the phone number displayed on your screen and 
provide your ID and password to our technicians.

FIREBIRD DATABASE
The TA software uses a Firebird embedded database. It is possible to copy this database and install it on any computer provided that it is running 
the Firebird Server software. After having changed the location of the database, you need to change the connection string in the software: Go to the 
Preference screen, in the database connection field, enter the new address of the database. Click on save. The software needs to be restarted.
For more information regarding the use of Firebird Server with your software, please contact our technical support.

UPDATES
Safescan is constantly working to offer you a better user experience. We regularly release updates for your software, improving current features or adding 
new ones. Every time an update is released, your software will give you a notification. We advise you to install these updates as soon as they are released. 


